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7 úoHq;a me;=reïm;a

	 	  
fuu mdvu yeoEÍfuka Tng

²	 me;=reïm;aj, uQ,sl myiqlï iy l%shdldß;ajh

²	 jevm;l ixrpl y÷kd .ekSu

²	 jevm;lg o;a; we;=<;a lsÍu yd ixialrKh lsÍu

²	 ir, .Kkh lsÍï i|yd fufyhjk iy w.hhka weiqßka iQ;% f.dv 

ke.Su

²	 iQ;% ,sùug fldaI ,smsk iy Y%s; Ndú;h

²	 jevm;la yeviõ lsÍu

²	 idfmalaI iy ksrfmalaI fldaI ,smsk Ndú;h  

²	 m%ia;dr ks¾udKh  

 ms<sn| ukd wjfndaOhla ,nd .ekSug yels jkq we;'

 7'1      úoHq;a me;=reïm;a

	 mqoa.,hkag tÈfkod lghq;=j, § fuka u jD;a;Shuh wjYH;d wkqj o úúO 

jQ .Kkh lsÍï lsÍug isÿ fõ' fuu .Kkh lsÍï i|yd úúO l%ufõo ñksid úiska 

Ndú; flf¾' .Kkh l< hq;= .eg¨fõ iajNdjh wkqj ir, .Kkh lsÍï ukiska 

yd w;e`.s,s Ndú;fhka o ixls¾K .Kkh lsÍï ,sÅ; j fyda .Kl hka;% u.ska o 

isÿ flf¾' fuu ld¾hh b;d u ksjerÈ j myiqfjka isÿ lsÍu ioyd  úoHq;a me;=reï 

m;a fhdod .kakd wdldrh .ek wOHhkh lruq'

	 l%uj;a j" ,sÅ; j .Kka iE§u ioyd fldgqrE,a fmd;a Ndú; lsÍu wfma 

idïm%odhsl l%uhhs' fuu fmdf;a iEu msgqjla u ;sria fma<s yd isria ;Srej,ska 

iukaú; h' fuu uQ,sl wdlD;sh mokï lr .ksñka fma<s yd ;Sre úYd, m%udKhlska 

iukaú; úoHq;a me;=reï m;a ks¾udKh lr we;'
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	 úoHq;a me;=reïm;a (Electronic Spreadsheets) Ndú;fhka my; oelafjk 

ld¾hhka ld¾hlaIuj;a ksjerÈj;a b;d myiqfjka isÿ lr .; yels h'

•	 ir, fuka u ixlS¾K .Kkh lsÍï

•   m%ia;dr u.ska o;a; ksrEmKh 

•	 o;a; wkqms<sfj<lska oelaùu

•   wjYH o;a; muKla fjkalr .ekSu

•   o;a;j, j,x.=;dj mÍlaId lsÍu

•   uqrmo fhdod o;a;j, wdrlaIdj ie,iSu

•	 miq Ndú;h i|yd iq/lSu

7'1'1  úoHq;a me;=reïm;a uDÿldx. 

	 úúO uDÿldx. ksIamdok iud.ï u.sska ksmojd we;s úoHq;a me;=reïm;a 

uDÿldx. lsysmhla j.=j 7'1 u.ska oelafõ' 
		

	       j.=j 7'1 - úúO me;=reïm;a uDÿldx. yd tAjdfha ksIamdok iud.ï

              uDÿldx.h	               ksIamdok iud.u

                    Excel           Microsoft Corporation
                    Numbers           Apple Inc
                    Libreoffice Calc           The Document Foundation
                    Openoffice Clac           Apache Foundation

		    

7'1'2  me;=reïm;a uDÿldx. l%shd;aul lsÍu

	 me;=reïm;a uDÿldx. w;ßka Microsoft Office Excel 2010 iy LibreOffice 
Calc hk uDÿldx. ms<sn| j muKla fuu tallfha § idlÉPd flf¾' uDÿldx.h 

wdrïN lrk wdldrh fufyhqï moaO;sh wkqj fjkia úh yelsh' 

	 Microsoft Office ksIamdok n,m;% iys; j ñ, § .; hq;= jk w;r 

LibreOffice ksIamdok ksoyia n,m;% iys; j Ndú; l< yels fõ'

Microsoft Office Excel 2010 i`oyd'''

Start → Programs→MicrosoftOffice 
→ Microsoft Office Excel 2010

LibreOffice Clac i`oyd'''

Start → Programs → Libre Office → 
Libre Office Clac 
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7'1'3  Microsoft Excel 2010ys w;=re uqyqK; yd tys ixrpl

	  	    	     	   

	   			 

	         		   rEmh 7'1 - Microsoft 2010ys w;=re uqyqK;

                                 

			   j.=j 7'2 - Microsoft Excel 2010ys ixrpl	

            ixrplh	                   úia;r

1'  blauka m%fõY fuj,ï ;Srej Save, Print Preview, Undo, New  jeks ks;r 

u wjYH jk úOdk ,nd fohs'

2'  ud;Dld ;Srej fhÿï uDÿldx.fha kduh o¾Ykh lrhs'

3'  ßnkh Home, Insert, Page Layout  jeks má;s 

hgf;a fuj,ï  ,nd fohs'

4'  Woõj Wojq ,nd .ekSug Wmldß fõ'

5'  md,k fnd;a;ï jevfmd;a ljq¿j úYd, lsÍu" l=vd lsÍu yd 

jeiSu isÿ lrhs'

6'  Y%s; wdodkh iQ;% f.dvke.Su i|yd ixjdo ljq¿j ,nd 

fohs'

7'  má;s ßnkh udre lsÍu isÿ lrhs'

8'  iQ;% ;Srej iQ;% o¾Ykh lsÍu iy fldaIhl wka;¾.;h 

o¾Ykh lsÍu isÿ lrhs'

10' kdu fldgqj

    Name Box

6' Y%s; wdÞkh 

Insert Function 	

 7' má;s 
Tabs

8' iQ;% ;Srej 

Formula Bar 9' ;Sre YS¾Il 

Column Headings

1' blauka m%fõY fuj,ï 

;Srej Quick Access Tool Bar
2'ud;Dld ;Srej

   Title Bar
  3' ßnkh

     Ribbon 4' Woõj

  Help

 5' md,k fnd;a;ï

    Control buttons

12' il%Sh fldaIh 

     Active Cell 

13' fma<s YS¾Il 

Row Headings

14' jevm;a     	

  má;s 
Sheet Tab

11' isria wkqp,k ;Srej

     Vertical Scroll Bar

15' ;ssria wkqp,k ;Srej

  Horizontal Scroll Bar

19' iQuh md,kh

Zoom Control
18' oel=ï fnd;a;ï 
View Buttons

17' ;;a;aj ;Srej 
Status Bar

16' má;s 

fmr<SSfï 

fnd;a;ï

Worksheet   
Navigation

10' kdu fldgqj          
Name Box
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9'  ;Sre YS¾Il ;Sre wlaIrh o¾Ykh lrhs'

10' kdu fldgqj l%shdldß fldaIfhys ,smskh o¾Ykh lrhs'

11' isria wkqp,k ;Srej jevm; isria j wkqp,k Wmldß fõ'

12' il%sh fldaIh o;a; wdodkh jk fldaIh o¾Ykh lrhs'

13' fma<s YS¾Il fma<s wxlh o¾Ykh lrhs'

14' jevm;a má;s jevm; ksfhdackh lrhs'

15' ;sria wkqp,k ;Srej jevm; wkqp,k fmr<Sug Wmldß fõ'

16' má;s wkqp,k fnd;a;ï jevm;a udre lsÍug Wmldß fjhs'

17' ;;a;aj ;Srej jevm; yd ine¢ ;;a;ajhka o¾Ykh lrhs'

18' oel=ï fnd;a;ï jevm;a o¾Ykh jk wdldr olajhs'

19' iQuh md,kh jevm; úYd, lr fyda l=vd lr fyda n,d 

.ekSug fhdod .efka'
		     		     

7'1'4  LibreOffice Calc 4'1 ys w;=reuqyqK; yd tys ixrpl

3' iïu; fuj,ï ;Srej 
  Standard Tool Bar

 2' fukq ;Srej

   Menu Bar

1' ud;Dld ;Srej

   Title Bar
5' kdu 

fldgqj   	

Name 
  Box

9' il%Sh fldaIh 

   Active Cell 

6' Y%s; wdÞkh  	

  Insert 	       
Function 7' iQ;% ;Srej 

Formula Bar 11' isria wkqp,k ;Srej

Vertical Scroll Bar

13' ;ssria wkqp,k ;Srej

   Horizontal Scroll Bar

16' ;;aj ;Srej 
     Status Bar

15' má;s fmr<Sfï fnd;a;ï 
      Worksheet Navigation

12' fma<s YS¾Il 

   Row Heading 

17' iQuh  md,kh

    Zoom Control

4' md,k fnd;a;ï 
   Control Buttons

8' yeviõ fuj,ï ;Srej

     Formating Tool bar

14' jevm;a má;s

      Sheet Tab

10' ;Sre YS¾Il 

   Column Heading
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                ixrplh                  úia;rh

1'  ud;Dld ;Srej fhÿï uDÿldx.fha kduh o¾Ykh 

lrhs'

2'  fukq ;Srej úOdk f;dard .ekSug myiqlï i,ihs'

3'  iïu; fuj,ï  ;Srej iïu; fuj,ï f;dard .ekSug 

myiqlï i,ihs'

4'  md,k fnd;a;ï jevfmd;a ljq¿j úYd, lsÍu"l=vd 

lsÍu" jid oeóu isÿ lrhs'

5'  kdu fldgqj il%sh fldaIfhys ,smskh o¾Ykh lrhs'

6'  Y%s; wdodkh iQ;% f.dv ke.Su i|yd  ixjdo ljq¿j 

,nd fohs'

7'  iQ;% ;Srej	 iq;% o¾Ykh lsÍu iy fldaIhl 

wka;¾.;h o¾Ykh lsÍu'

8'  yeviõ fuj,ï ;Srej jevm; yeviõ lsÍug Wmldr fõ'

9'  il%sh fldaIh o;a; wdodkh jk fldaIh o¾Ykh 

lrhs'

10' ;Sre YS¾Il ;Sre wlaIrh o¾Ykh lrhs'

11' isria fmr<k ;Srej jevm; isria j fmr<Sug Wmldr fõ'

12' fma<s  YS¾Il fma<s wlaIrh o¾Ykh lrhs'

13' ;sria fmr<k ;Srej jevm; ;sria j fmr<Sug Wmldr fõ'

14' jevm;a má;s jevm; ksfhdackh lrhs'

15' má;s fmr<Sfï fnd;a;ï  jevm;a fmr<Sug Wmldr fjhs'

16' ;;a;aj ;Srej jevm;  yd ine¢ ;;a;aj o¾Ykh 

lrhs'

17' iQuh jevm; úYd, lr fyda l=vd lr fyda 

n,d .ekSug fhdod .efka'

7'1'5  jevm; (Worksheet)

	 oaúudk ;,hl isria ;Sre (Columns) yd ;sria fma<s ^Rows& jYfhka msysá 

fldaI iuQyhlska jevm; (Worksheet) ks¾udKh ù we;' th jevm;a má;s (Sheet 
Tab)  u.ska olajkq ,nhs'

j.=j 7'3 - LibreOffice Calc 4'1 ys ixrpl
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7'1'6  jevm;l ;Sre kï lsÍu

	 jevm;l we;s ;Sre kï lr we;af;a my; oelafjk mßÈ bx.%Sis lemsg,a 

wlaIr fyda wlaIr ixfhdack fyda u.sks' rEmh 7-3 n,kak'

A,B,C,D,'''''''''''''''''''''''Z olajd o 

AA,AB,AC.AD,AE,.................AZ olajd o 

BA,BB,BC,BD,BF.................BZ olajd o     wdÈ jYfhks'

7'1'7  jevm;l fma<s kï lsÍu

	 jevm;l we;s fma<s kï lr we;af;a 1" 2" 3" 4" 5"''''''''wdÈ jYfhka wxl u.sks' 

rEmh 7-3 n,kak'

	

	  

	 idudkHfhka jevm;l fma<s m%udKh iy ;Sre m%udKh 2ys n,hla jk 

w.hlska mj;S'

me;=reï m;a uDÿldx.h	 		  fma<s m%udKh	 	 ;Sre m%udKh	

Microsoft Excel 2003				    65536	 ^216&		   256 ^28&

Microsoft Excel 2007$2010			   1048576 ^220&		  16384 ^214&

LibreOffice Calc  4'1				   1048576 ^220&		  1024 ^210&

fma<s

Rows
  ;Sre

Column

rEmh 7'3 - jevm;l fma<sj, yd ;Srej, msysàu'
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7'1'8  il%sh fldaIh

	 jevfmf;ys o;a; wdodkhg m%:ufhka tu fldaIh f;dard .; hq;= h' tfia 

f;dard .;a fldaIhla il%sh fldaIh (Active Cell) f,i ye¢kafjhs' my; oelafjk 

wjia:dfõ §  B3 fldaIh il%sh j mj;shs' il%sh fldaIh iEu úg u ;o fndavrhlska 

o¾Ykh fõ' rEmh 7'4 n,kak'

 7'2      jevm; ;=< ießieÍu

	

	 jevm;lg o;a; we;=<;a lsÍfï § m%:ufhka o;a; we;=<;a l< hq;= fldaIh 

il%sh l< hq;= h'

	 my; oelafjk h;=r$h;=re ixfhdack l%shd;aul lsÍfuka jevm; ;=< msysá 

´kE u fldaIhla fj; .uka lr th il%sh l< yels h'

h;=r$h;=re ixfhdackh			   m%;sM,h

Arrow keys		    wod< ÈYdjg^jug" ol=Kg" by<g" my<g& tla fldaIhla  

			     .uka lrhs'

Ctrl  + Arrow Keys	   wod< ÈYdjg o;a; we;=<;a mrdifhys wka; fj; .uka  

			     lrhs'

Home			     il%sh fldaIh msysá fma<sh Tiafia A ;Srej fj; .uka lrhs'

Ctrl + Home	 	   A1 fldaIh fj; .uka lrhs'

Ctrl + End	 	  o;a; we;=<;a mrdifhys ol=Kq mi my< fldaIh fj;  .uka 

			     lrhs'

Page Up		    jevmf;ys tla ;srhla by<g .uka lrhs'

Page Down		    jevmf;ys tla ;srhla my<g .uka lrhs' 

rEmh 7'4 - jevm;l il%sh fldaIh
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7'2'1  fldaI ,smskh 

	 m<uq j ;Srefõ wlaIrh;a fojkq j fma<sfha wxlh;a fhdod fldaIh kï 

flf¾' th fldaI ,smskh (Cell Address) f,i ye¢kafõ' il%sh fldaIfha ,smskh 

kdu fldgqj u; Èiafõ' ^rEmh 7'1 iy 7'2 n,kak'&

Wod(  D ;Srefõ 3 jk fma<sfha msysá fldaIh D3 f,i kï flf¾' rEmh 7'5 n,kak'

7'2'2  fldaI mrdih 

	 jevmf;ys wkqhd; fldaI iuQyhla fldaI mrdih (Cell Range) f,i 

ye¢kafõ' my; oelafjk jevm;a i,lkak'

kdu fldgqj Name Box
il%sh fldaIh Active Cell 

rEmh 7'5 - jevm;l il%sh fldaIh
  l%shdldrlu

KD74 hk fldaI ,smskh msysá fma<sh '''''''''' jk w;r ;Srej ''''''''''' fõ'

rEmh 7'6 - jevm;l ;Srejla Tiafia we;s

fldaI mrdihla  

	 fuu fldaI mrdihg B2, B3, B4, 
B5 hk fldaI 4 we;=<;a fõ' mrdih B2 ka 

wdrïN lr B5ka wjika lr we;' 

	 fuu fldaI mrdih B2:B5 uÕska  

ksrEmKh fõ' 

	 ;Srejla Tiafia we;s fldaI mrdihl 

;Srefõ wlaIrh ksh; j mj;shs'

	 fuu fldaI mrdihg A3, B3, 
C3 hk fldaI 3 we;=<;a fõ' rEmh 7'7 

n,kak'

	 fuu fldaI mrdih A3:C3 
u.ska ksrEmKh fõ' 

	 fma<shla Tiafia we;s fldaI 

mrdihl fma<s wxlh ksh; j mj;S' rEmh 7'7 - jevm;l fma<shla Tiafia we;s

fldaI mrdihla  
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	 fuu fldaI mrdih B2:C4 u.ska ksrEmKh fõ' ^rEmh 7'8 n,kak'&

fma<s iy ;Sre Tiafia we;s fldaI mrdihl fma<s wxl;a" ;Sre wlaIr;a fjkia fõ' 

igyk( jevm;l fldaI mrdi lSmhla oelaùu i|yd md,k h;=r (Control Key) 
fhdod .ksñka i,l=Kq lrkq ,efí' h;=re mqjrefõ  md,k h;=r Ctrl uÕska olajd 

we;'

	 fuu fldaI mrdihg B2, B3, B4, 
C2, C3, C4 hk fldaI 6 we;=<;a fõ' 

^rEmh 7'7 n,kak'&

rEmh 7'8 - jevm;l fma<s yd ;Sre Tiafia we;s

fldaI mrdihla  

  l%shdldrlu

rEmh 7'9 u.sska oelafjk jevm; weiqßka my; wid we;s m%Yakj,g 

ms<s;=re i|yka lrkak' 

^1&   R 1 u.sska oelafjk mrdifhys wdrïNl fldaIfhys ,smskh l=ula o@

^2&  R 1 u.sska oelafjk mrdifhys wjidk fldaIfhys ,smskh l=ula o@

^3&  R 1 u.sska oelafjk mrdih i|yka lrkak'

^4&  R 2 u.sska oelafjk mrdih i|yka lrkak'

^5&  fma<shla Tiafia msysá mrdih l=ula o@

^6&  ;Srejla Tiafia msysá mrdih l=ula o@

^7&  R 3 u.sska oelafjk mrdih i|yka lrkak'

^8&  R 3 u.sska oelafjk mrdihg wh;a fldaI .Kk i|yka lrkak'

R1
R2R3

rEmh 7'9 - jevm;l we;s fldaI mrdihla  



209fkdñf,a fnod yeÍu msKsihsfkdñf,a fnod yeÍu msKsihs208

7'2'3  o;a; we;=<;a lsÍu 

	 me;=reïm;g o;a; we;=<;a lsÍug fmr wod< fldaIh il%sh l< hq;= h' bka 

miq o;a; we;=<;a l< hq;= h' fldaIhl wka;¾.;h jkafka f,an,a (Label)" w.hka 

(Value) fyda iQ;% (Formula) hk tajdhska tlls'

1'f,an, 

	 h;=re,shkh lrk ,o wlaIr (Letters)" ixLHd (Numbers)" úfYaI ixfla; 
(Special Symbols) u.ska fyda tajd ixfhdackfhka fyda ,nd .kakd mdG (Text) 
f,an, f,i ye¢kafõ' idudkHfhka f,an, fldaIhl jï tfl,a, fõ (Left Align)' 

my; rEmh 7'10 u.sska jevm;l f,an, jï tfl,a, j mj;sk wdldrh oelafõ' 

igyk ( fuys ÿrl:k wxl we;=<;a lsÍfï § my; oelafjk wdldrfhka u 

fldaIj, o¾Ykh fkd fõ' ^ÿrl:k wxlfha uq,ska u we;s 0 o¾Ykh fkdfõ&' 

f,an, wdldrfhka mj;ajd .ekSug ÿrl:k wxl we;=<;a l< hq;= fldaI mrdih 

mdG(Text) f,i yeviõ l< hq;= h' fldaI yeviõ lrk wdldrh miq j idlÉPd 

flf¾'

		      

2' w.hka 

	 ixLHd;aul jákdlula iys; o;a; w.hka f,i i,lkq ,nhs' idudkHfhka 

w.hka fldaIhl ol=Kq tfl,a, fõ (Right Align)' w.hka f,i mj;sk o;a;  

wdldr lSmhla rEmh 7'11 u.ska oelafõ'

  rEmh 7'10 - jevm;l f,an, jï tfl,a, ùu'

:

rEmh 7'11 - jevm;l w.hka  ol=Kq tfl,a, ùu
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igyk (  Nd. ixLHdjla we;=<;a lsÍfï § mQ¾K ixLHdj ghsma lr ;ks wjldYhlg            

(Single Space) miq j Nd. fldgi ghsma lrkak'

3' iQ;%

	 .Kkh lsÍu Wfoid iudk ̂ }& ,l=‚ka wdrïN lr w.hhka" fldaI ,smsk iy 

Y%s; fhdod .ksñka ,shkq ,nk m%ldYk iQ;% f,i ye¢kafjhs' jevmf;a fldaIhlg 

iQ;%hla we;=<;a l< úg tu.sska .Kkh jQ w.h fldaIh ;=< Èiajk w;r iQ;%h iQ;% 

;Srefõ Èiafõ'

WodyrK 1 -   A1 iy  B1 fldaIj, wka;¾.;j, tl;=j C1 fldaIh ;=<g ,nd 

.ekSu' ^rEmh 7'12 n,kak&

 
	

	 fufyhjkh		     w¾:h

		  ¬		  tl;= lsÍu

		  -		  wvq lsÍu

		  *		  .=K lsÍu

		  /		  fn§u

		  ^		  n,h

igyk ( fufyhjk l%shd;aul jk wkqms<sfj< jryka fhdod fjkia l< yels h' 

túg jryka iys; fldgi m%:ufhka iq¿ fõ'

iQ;%fhka .Kkh jQ w.h

iQ;% ;Srej

C1 fldaIhg we;=<;a l< iQ;%h

rEmh 7'12 - iQ;% o¾Ykh jk whqre

 7'3 iQ;% ,sùu i|yd Ndú; lrkq ,nk .‚;uh fufyhjk
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fufyhjk m%uqL;d wkqms<sfj< (Operator Precedence)	

	 m%:u		  ^ &

	 fojk		  ^
	 f;jk		 * " $
	 isõjk		 ¬ " -        by, isg my,g wvq fõ'

7'3'1  w.hka iy fufyhjk Ndú;fhka ir, .Kkh lsÍï isÿlsÍu

w.hka iy fufyhjk fhdod ,shk ,o ir, iQ;% lsysmhla j.=j 7'4 u.sska oelafõ'
	 			 

				    j.=j 7'4 - ir, iQ;% ,sùu

      fufyhjkh            iQ;%h          m%;sM,h

tl;= lsÍu ^ ¬ &            = 2¬4              6

wvq lsÍu   ^ - &	            = 5-2              3

.=K lsÍu  ^ * &            = 4*5             20

fn§u ^ $ &            = 12$6              2

n,h ^^&		             = 2^4             16

	 		          

	 iQ;%hla ;=< fufyhjk lsysmhla mej;sh yels h' tjeks iQ;% wkqms<sfj<sska 

iq¿ lrk wdldrh oek .ksuq' fï i|yd 7'5 iy 7'6 j.= n,kak'

			      j.=j 7'5 - ir, iQ;%j, jryka Ndú;h

           iQ;%h     iq¿ lrk wdldrh          m%;sM,h

= 2¬4*3       = 2¬12 = 14

= ^2¬4&*3       = 6*3 = 18

= 4*3^2       = 4*9 = 36

= (4*3)^2       = 12^2 = 144
			 

WodyrKh = 5¬2*3^2$6-3 = 5¬2*3^2$^6-3& = 8$2*3-2^3¬5

iq¿ lrk mshjr = 5¬2*3^2$6-3 = 5¬2*3^2$^6-3& = 8$2*3-2^3¬5

= 5¬2*9$6-3 = 5¬2*3^2$3 = 8/2*3-8¬5

= 5¬18$6-3 = 5¬2*9$3 = 4*3-8¬5

= 5¬3 - 3 = 5¬18$3 = 12-8¬5

= 8-3 = 5¬6 = 4¬5

ms<s;=r = 5 = 11 = 9

j.=j 7'6 - iQ;% iq¿ lrk mshjr
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igyk ( jryka Ndú; fkdjk úg iu uÜgfï mj;sk .=K lsÍu ^ * & yd fn§u 

^ $ & hk fufyhjk o " tl;= lsÍu ^ ¬ & yd wvq lsÍu ^ - &  hk fufyhjk o 

iQ;%fha jï mi isg ol=Kq mig msysgd we;s wkqms<sfj< wkqj iq¿ lrkq ,nhs'

7'3'2  fldaI ,smsk yd fufyhjk Ndú;fhka  iQ;% f.dv ke.Su
	

	 fldaI ,smsk iy fufyhjk Ndú;fhka iQ;% ,sùfuka w;ajk m%Odk;u 

jdish jkafka iQ;%hg wod< fldaIj, wka;¾.;h fjkia jk úg tu iQ;%h uÕska 

.Kkh lrkq ,nk w.hka iajhxl%Sh j u hdj;ald,Sk ùuhs'

  WodyrK 1

RcqfldaKdi%hl mßñ;sh yd j¾.M,h fiùu i|yd tys È. yd m<, ms<sfj<sska 
A2 iy B2 fldaIj,g we;=<;a lruq' mßñ;sh fiùug  C2, C3, C4 fldaIj, iy 

j¾.M,h fiùug D2 fldaIfha wod< iQ;% olajd we;'  7'13 rEmh n,kak'

     rEmh 7'13 - iDcqfldaKdi%hl mßñ;sh yd j¾.M,h

  l%shdldrlu

	    my; oelafjk iQ;% iq¿ lsÍfuka ,efnk  w.hhka fidhkak'  

	 	 ^1& = 6-4$2	 ^6& = 4¬5*2^3	    ^11& = 5$2¬1^3*4
	 	 ^2& = 5*4¬3	 ^7& = 8$4*2	    ^12& = 3-4*3$2
	 	 ^3& = 3¬4*5	 ^8& = -4$2¬2	    ^13& = 6$3*2^1-3
		  ^4& = 2^5¬3	 ^9& = 1¬2^2*3	    ^14& = 3*^2¬4&$9¬1
		  ^5& = 3¬5^2	 ^10& = 3*4$2	    ^15& = 2^3$^5-1^3&*5

  l%shdldrlu

7'13 rEmfha oelafjk jevm; Tn Ndú; lrk me;=reïm;a uDÿldx.h 

weiqßka ks¾udKh lrf.k A2 iy B2 hk fldaIj, w.hka fjkia 

lrñka C iy  D ;Srej, i|yka iQ;%j,ska ,efnk m%;sM, ksÍlaIKh 

lrkak'
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b;d jeo.;a ( D2 fldaIhg wod< iQ;%h  D2=A2*B2 f,i ,sùfuka th f,an,hla 

njg m;aùfuka .Kkh ùula isÿ fkdfõ'^rEmh 7'14 n,kak'& tu ksid iQ;% ,sùfï 

§ = ,l=Kg jï miska lsisjla igyka fkdl< hq;= h' ^rEmh 7-15 n,kak'&

  WodyrK 2

fmd;l ñ, iy mekai,l ñ, § we;s úg rEmh 7'16 u.sska oelafjk jevmf;ys 

i|yka iQ;% n,kak'

WodyrK 3

>klhl me;a;l È. § we;s úg j¾.M,h iy mßudj .Kkh lsÍu' ^rEmh 7'17 

n,kak'&

rEmh 7'14 - iQ;%hla jeros f,i ksrEmKh rEmh 7'15 - iQ;%hla ksjeros f,i ksrEmKh

rEmh 7'16 - ñ, .Kkh

rEmh 7'17 - >klhl j¾. M,h yd mßudj fiùu'

  l%shdldrlu

7'16 rEmfha oelafjk jevm; Tn Ndú; lrk me;=reïm;a uDÿldx.h 

weiqßka ks¾udKh lrf.k B1 iy B2 hk fldaIj, w.hka fjkia 

lrñka B3, B4, B5, B6 hk fldaIj, i|yka iQ;%j,ska ,efnk m%;sM, 

ksÍlaIKh lrkak'
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igyk ( fldaI ,smsk Ndú;fhka ,shk ,o iQ;%j,ska ,efnk m%;sM,h" iEu úg 

u tu iQ;% ,sùug fhdod .;a fldaI ,smskj, w.hka fjkia l< úg iajhxl%Sh j 

hdj;ald,Sk fõ' 

               iQ;%h                  m%;sM,h

=A1*B1-D2
=D1-C2/A2
=B3^C3-A3
=A1*C1/C3
=D2*C4*E1
=A3/B3+A2*D1
=A1+(B2*C2)-B3+C2/B2
=B2-B3+B1*(D1+D2^B1)
=A2^B3-C2+A3*(B3+C1)
=A3/C3*(D2*D1)
=D3/C3/B3*A3+B2
=(D3/(A1+B2))^C2

	      j.=j 7.7

  l%shdldrlu

 7'17 rEmfha oelafjk jevm;  Tn Ndú; lrk me;=reïm;a uDÿldx.h 

weiqßka ks¾udKh lrf.k B1 fldaIfha w.hka fjkia lrñka 

B2,B3,B4 hk fldaIj, i|yka iQ;%j,ska ,efnk m%;sM, ksÍlaIKh 

lrkak'

  l%shdldrlu

my; oelafjk jevm; ^rEmh 7'18 n,kak& iy iQ;% we;=<;a j.=j  

wOHhkh lrñka j.=j 7'7 ys i|yka iQ;%j, fufyhjk fh§ we;s 

m%uqL;d wkqms<sfj< i,ld n,ñka iq¿lr ,efnk wjidk w.h m%;sM, 

;Srefõ igyka lrkak' 

iQ;%h m%;sM,h

=A1+B1 12
=C1+C2+C3	 17
=B2+C3+B3	 7
=A2*C1	 12
=C2/A2*D1 6
=B3^A2+D1 10

rEmh 7'18 - o;a; we;=<;a jevm;
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 7'4      .Kkh lsÍu i`oyd Y%s; Ndú;h 	

	 o;a; m%udKh jeä jk úg fldaI ,smsk muKla  Ndú;fhka iQ;% ,sùu 

;rula wmyiq iy ixlS¾K lghq;a;ls' tjeks wjia:dj, § iQ;% ,sùu i|yd Y%s; 

Ndú; lruq' me;=reïm;a uDÿldx.j, úúO lafIa;% hgf;a .Kkh lsÍï isÿ lsÍug 

Y%s; úYd, m%udKhla we;' ta w;ßka nyq, j fhfok uQ,sl Y%s; lsysmhla y÷kd 

.ksuq' ^j.=j 7'8 n,kak'&

 Y%s;fha ku     ldrl Í;sh (Syntax)             Ndú;h

SUM =SUM (Number 1,Number2......) fldaI mrdihl msysá w.hkaf.a 

tl;=j fiùu'

AVERAGE	 =AVERAGE (Number1,Number2.......)	 fldaI mrdihl msysá w.hkaf.a 

idudkH w.h fiùu'

 MAX =MAX (Number1,Number2.......) fldaI mrdihl msysá w.hkaf.a 

úYd,u w.h fiùu'

 MIN =MIN (Number1,Number2......) fldaI mrdihl msysá w.hkaf.a 

l=vdu w.h fiùu'

COUNT =COUNT (Number1,Number2.......) fldaI mrdihl msysá w.hka 

we;=<;a fldaI .Kk fiùu'

				       

	 WodyrKhla f,i jevm;l A1 fldaIfha isg A10 fldaIh olajd tl;=j ,nd 

.ekSug fldaI ,smsk muKla Ndú;fhka 1 u.ska oelafjk iQ;%h iy Y%s; 

Ndú;fhka ,shk ,o 2 u.ska oelafjk iQ;%h i,luq' fuu iQ;% foflka u tl 

u m%;sM,hla ,nd fohs' fuu iQ;% fol ii|d n,k úg fldaI mrdih jeä jk 

úg 2 u.ska oelafjk iQ;%h Ndú;h ir, yd myiq nj Tng jegfykjd we;'

j.=j 7.8
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=A1+A2+A3+A4+A5+A6+A7+A8+A9+A10		     1
=SUM(A1:A10)						         2

=A1+A2+A3+A4+A5+A6+A7+A8+A9+A10

	           =SUM( A1: A10)

    

	 Y%s;h ;=< mrdih wdrïN jk fldaI ,smskh;a mrdih wjika jk fldaI 

,smskh;a igyka lrkq ,nhs'

rEmh 7'19 u.ska oelafjk jevm; weiqßka Y%s; Ndú;fhka iQ;% f.dvk.uq'

Y%s; Ndú; l< yels úúO wdldr y÷kd .ksuq'

SUM Y%s;h' ^j.=j 7'9 n,kak'&
j.=j 7.9

           iQ;%h          úia;rh      m%;sM,h

= SUM (A1,B1,C1) A1,B1 iy C1 hk 

fldaIj, w.hkaf.a tl;=j'

        12

= SUM (A1:C1) A1 isg C1 olajd fldaI mrdih ;=< 

msysá w.hkaf.a tl;=j'

        12

= SUM (A1:C1,B2) A1 isg C1 olajd fldaI mrdih ;=< 

iy B2 fldaIfhys we;s w.hkaf.a 

tl;=j'

        15

= SUM (B1:C2) B1 isg C2 olajd fldaI mrdih ;=< 

msysá w.hkaf.a tl;=j'

        20

= SUM 
(A1:A3,C1:C3)

A1 isg A3 olajd iy C1 isg 

C3 olajd fldaI mrdi ;=< we;s 

w.hkaf.a tl;=j'

            35

rEmh 7'19 - jevm;
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AVERAGE Y%s;h ^j.=j 7.10&

           iQ;%h          úia;rh          m%;sM,h

= AVERAGE (A1,B1,C1) A1,B1 iy C2 hk fldaIj, 

w.hkaf.a idudkHh'

           4'00

= AVERAGE (A1:C1) A1 isg C1 olajd fldaI 

mrdih ;=< msysá w.hkaf.a 

idudkHh' 

           4'00

= AVERAGE (A1:C1,B2) A1 isg C1 olajd fldaI 

mrdih ;=< iy B2 fldaIfhys 

we;s w.hkaf.a idudkHh'

           3'75

= AVERAGE (B1:C2) B1 isg C2 olajd fldaI mrdih 

;=< msysá w.hkaf.a tl;=j'

           5'00

= AVERAGE(A1:A3,C1:C3) A1 isg A3 olajd iy C1 isg 

C3 olajd fldaI mrdi ;=< 

we;s w.hkaf.a idudkHh'

                5.83

					   

igyk ( idudkH w.h i|yd úúO oYu ia:dk iys; ms<s;=re m%;sM, ,efí' tu 

m%;sM, we;=<;a fldaI mrdih wjYH oYuia:dk m%udKhlg yeviõ (Format) l< 

hq;= h'

MAX Y%s;h ^j.=j 7'11&

j.=j 7.11

         iQ;%h              úia;rh       m%;sM,h

= MAX (A1,B2,C1) A1"B2 iy C1 hk fldaIj, w.hka 

w;ßka úYd, u w.h h'

          4

= MAX (A2:C2,B3) A2 isg C2 olajd fldaI mrdih 

;=< iy B3 fldaIfhys we;s w.hka 

w;ßka  úYd, u w.h h'

          9

= MAX(A1:C1) A1 isg  C1 olajd fldaI mrdih 

;=< msysá w.hka w;ßka  úYd, u 

w.h h'

          6

= MAX (A1,B1:C2) A1iy B1 isg  C2 olajd fldaI 

mrdih ;=< msysá w.hka w;ßka  

úYd, u w.h h'

          7

j.=j 7.10



217fkdñf,a fnod yeÍu msKsihsfkdñf,a fnod yeÍu msKsihs216

					   

MIN Y%s;h ^j.=j 7'12 n,kak&

       iQ;%h              úia;rh      m%;sM,h

= MIN (A1,B2,C1) A1"B2 iy C1 hk fldaIj, w.hka 

w;ßka l=vd u w.h h'

        3

= MIN (A2:C2,B3) A2 isg C2 olajd fldaI mrdih 

;=< iy B3 fldaIfhys we;s w.hka 

w;ßka l=vd u w.h h'

        3

= MIN (A1:C1) A1 isg  C1 olajd fldaI mrdih ;=< 

msysá w.hka w;ßka l=vd u w.h h'

        2

= MIN (A1,B1:C2) A1 iy B1 isg  C2 olajd fldaI 

mrdih ;=< msysá w.hka w;ßka l=vd 

u w.h h'

        2

COUNT Y%s;h ^j.=j 7'13 n,kak&'

         iQ;%h          úia;rh        m%;sM,h

= COUNT (A1,B1) A1, B1 iy C1 hk fldaIj, 

we;s w.hka .Kk'

          2

= COUNT (A1:C1) A1 isg C1 olajd fldaI mrdih 

;=< msysá w.hka .Kk'

          3

= COUNT (A1:A4) A1 isg A4 olajd fldaI mrdih 

;=< msysá w.hka .Kk'

          3

= COUNT (A1:C1,B2) A1 isg C1 olajd fldaI mrdih 

;=< iy B2 fldaIfhys we;s 

w.hka .Kk'

          4

= COUNT (B1:C3) B1 isg C3 olajd fldaI mrdih 

;=< msysá w.hka .Kk'

          6

= COUNT (A1:A3,C1:C3) A1 isg A3 olajd iy C1 isg 
C3 olajd fldaI mrdi ;=< we;s 

w.hka .Kk'

          6

				  

j.=j 7.12

j.=j 7.13
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  l%shdldrlu

mdi,l f;dr;=re yd ikaksfõok ;dlaIKh yodrk isiqka yh fofkl=  

10 mka;sfha § ,nd .;a ,l=Kq rEmh 7'20ys olajd we;' 

		    rEmh 7'20 - mdi,l isiqka 10 jif¾ § ICT i`oyd ,nd .;a ,l=Kq

Y%s; muKla fhdod .ksñka my; m%Yakj,g ms<s;=re imhkak'

^1& fla'Ndkq fidaur;ak ,nd .;a ,l=Kqj, tl;=j fiùug F2 fldaIhg we;=<;a  

    l< hq;= iQ;%h i|yka lrkak' 

^2& jika;ï chrdÊ ,nd.;a ,l=Kqj, idudkH w.h fiùug F3 fldaIhg we;=<;a  

    l< hq;= iQ;%h i|yka lrkak' 

^3& jdrh 1 i|yd ,nd we;s jeä u ,l=Kq ixLHdj fiùug B8 fldaIhg we;=<;a l< 

    hq;= iQ;%h i|yka lrkak' 

^4& jdrh 2 i|yd fmkS isá isiqka ixLHdj fiùug C8 fldaIhg we;=<;a l< hq;=  

    iQ;%h i|yka lrkak' 

^5& jdrh 3 i|yd ,nd we;s wvq u ,l=Kq ixLHdj fiùug D8 fldaIhg we;=<;a l<  

   hq;= iQ;%h i|yka lrkak' 
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7'5'1  Microsoft Excel 2010 ys yeviõ lsÍfï fuj,ï iys;  
	   ßnkh

		  	 		  j.=j 7.14

 wxlh        fuj,u             úia;rh

      1 Font jevmf;ys úúO j¾.fha wlaIr fhdod 

.ekSu'

      2 Font Size jevmf;ys úúO m%udKfha wlaIr fhdod 

.ekSu'

      3 Vertical Top Alignment fldaIh ;=< isria j by<ska msysgqùu'

      4 Vertical Middle Alignment fldaIh ;=< isria j ueÈka msysgqùu'

      5 Vertical Bottom Alignment fldaIh ;=< isria j my<ska msysgqùu'

      6 Orientation fldaI wka;¾.;h wdk; j msysgqùu'

      7 Number Format w.hka iys; fldaI yeviõ lsÍu'

      8 Bold fldaI wka;¾.;h ;o meye .ekaùu'

      9 Italic fldaI wka;¾.;h we, j msysgqùu'

     10 Underline fldaI wka;¾.;hg háka brla we£u'

     11 Left Alignment fldaIh ;=< ;sria j jï tfl,a, lsÍu'

     12 Center Alignment fldaIh ;=< ;sria j ueo tfl,a, lsÍu' 

     13 Right Alignment fldaIh ;=< ;sria j ol=Kq tfl,a, lsÍu'

     14 Increase decimal places w.hkaf.a oYu ia:dk m%udKh jeä lsÍu'

     15 Decreased  decimal places w.hkaf.a oYu ia:dk m%udKh wvq lsÍu'

 

	 jevm;l wka;¾.;fhys we;s f,an, iy w.hka yeviõ (Formatting) 
lsÍug yeviõ fuj,ï ;Srej fyda fldaI yeviõ ixjdo ljq¿j Ndú; l< yels h'

 7'5      jevm; yeviõ lsÍu

21 3

1310 11 151412

5 6

9

7

8

4

 rEmh 7'21 - Microsoft Excel 2010 yeviõ fuj,ï ;Srej
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7'5'2  LibreOffice  Calc j, yeviõ lsÍfï fuj,ï ;Srej

 

    	

				           j.=j 7.15

           

wxlh

         fuj,u          úia;rh

1 Font jevmf;ys úúO j¾.fha Font fhdod 

.ekSu'

2 Font Size jevmf;ys úúO m%udKfha Font fhdod 

.ekSu'

3 Bold fldaI wka;¾.;h ;o meye .ekaùu'

4 Italic fldaI wka;¾.;h we, j msysgqùu'

5 Underline fldaI wka;¾.;hg háka brla we£u'

6 Left Alignment fldaIh ;=< jï tfl,a, lsÍu'

7 Center Alignment fldaIh ;=< ueo tfl,a, lsÍu'

8 Right Alignment fldaIh ;=< ol=Kq tfl,a, lsÍu'

9 Increase decimal places w.hkaf.a oYu ia:dk m%udKh jeä lsÍu'

10 Decreased  decimal 
places

w.hkaf.a oYu ia:dk m%udKh wvq lsÍu'

8

3 4 5 61 2

7 9 10

rEmh 7'22 - LibreOffice  Calc 4.1 yeviõ fuj,ï ;Srej
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7'5'3  w.hhka yeviõ lsÍug ixjdo ljq¿ Ndú; lsÍu

	 fldaIhla fyda fldaI mrdi fyda yeviõ lsÍug fuj,ï ;Srefõ msysá 

fuj,ïj, úia;rd;aul Ndú; fldaI yeviõ ixjdo ljq¿(Format Cells Dialog 
Box) ;=<sska n,d .; yels h'

7'5'4  fldaI mrdihla oYuia:dk lsysmhlg yeviõ lsÍu 

	 w.hka fnok úg oYu ia:dk úúO m%udKj,ska ,efí' tjeks wjia:dj, § 

ksYaÑ; oYu ia:dk m%udKhlg yeviõ l< hq;= fõ' rEmh 7'25 n,kak'

	 fldaI wjYH oYu ia:dk m%udKhlg  yeviõ lsÍu i|yd  my; oelafjk 

mshjr wkq.ukh lrkak'

rEmh 7'25 - oYu ia:dk follg yeviõ lsÍu'

	 rEmh 7'23 - fldaI ixjdo yeviõ ljq¿ 	 rEmh 7'24 - fldaI ixjdo yeviõ ljq¿

Microsoft Office Excel 2010 i`oyd... 
Home Tab  → Number Group LibreOffice Clac i`oyd...

Format→Cells
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7'5'5 fldaI mrdihla f,an, f,i oelaúh yels wdldrhg yeviõ  
         lsÍu

	 ÿrl:k wxlhl b,lalï oyhla wvx.= úh hq;= h' tfy;a me;=reï m;aj, 

§ fldaIhla ;=< § uq,ska wdodkh lrkq ,nk ìkaÿj ^0& fmkajkafka ke;' thg 

fya;=j th w.hla f,i igyka lr .ekSuhs' tneúka ÿrl:k wxl wdodkh lsÍug 

m%:ufhka we;=<;a lrkq ,nk fldaI mrdih mdG ^Text& f,i yeviõ l< hq;= h' 

^rEmh 7'26 iy rEmh 7'10 ys D ;Srej n,kak'&

	 fldaI mrdihla mdG (Text) wdldrhg yeviõ lsÍu i|yd my; oelafjk 

mshjr wkq.ukh lrkak'

Microsoft Office Excel  2010 i`oyd...

1' fldaI mrdih f;dard .ekSu'

2' w.hka yeviõ ixjdo fldgqj ,nd 

   .ekSu'

3' Number Tab f;dard .ekSu' 

4' Number f;dard .eksu'

5' wjYH oYu ia:dk m%udKh ilia lsÍu'

6' OK úOdkh l%shd;aul lsÍu'

LibreOffice Calc i`oyd...
1' fldaI mrdih f;dard .ekSu'

2' w.hka yeviõ ixjdo fldgqj ,nd 	

   .ekSu'

3' Number Tab f;dard .ekSu' 

4' Number f;dard .eksu'

5' wjYH oYu ia:dk m%udKh ilia lsÍu'

6' OK úOdkh l%shd;aul lsÍu'

rEmh 7'26 - fldaI mrdihla mdG (text) wdldrhg 

yeviõ lsÍu

Microsoft Office Excel  2010 i`oyd...

1' fldaI mrdih f;dard .ekSu

2' w.hka yeviõ ixjdo fldgqj ,nd 

   .ekSu

3' Number Tab f;dard .ekSu

4' Text f;dard .ekSu

5' OK úOdkh l%shd;aul lsÍu

6' ixLHd wdÞkh lsÍu

LibreOffice Calc i`oyd...
1' fldaI mrdih f;dard .ekSu

2' w.hka yeviõ ixjdo fldgqj ,nd 	

   .ekSu

3' Number Tab f;dard .ekSu

4' Text f;dard .ekSu

5' OK úOdkh l%shd;aul lsÍu

6' ixLHd wdÞkh lsÍu
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7'5'6 fldaI mrdihla m%;sY; oelaúh yels wdldrhg yeviõ lsÍu

	 tla w.hla ;j;a w.hlska fn¥ úg ,efnk ixLHdj m%;sY;hla (Percentage) 
f,i ±laùug yeviõ l< hq;= h' mdi,a fmd;a wf,ú if,ys m<uq jdrh ;=< ,o 

udisl wdÞhu m%;sY;hla f,i .Kkh lr we;s whqre 7'27 rEmfhka ±lafõ'

rEmh 7'27 - fldaI mrdihla m%;sY; (Percentage) wdldrhg yeviõ lsÍu

	 fldaI mrdihla m%;sY; wdldrhg yeviõ lsÍu i|yd my; oelafjk mshjr 

wkq.ukh lrkak'

7'5'7 fldaI mrdihla úoHd;aul ixLHd oelaúh yels wdldrhg 
          yeviõ lsÍu

	 me;=reïm;aj, b;d l=vd ixLHd fuka u b;d úYd, ixLHd o .Kkh lsÍug 

yelshdj we;' tjeks w.hka lshjd f;areï .ekSu yd m%ldY lsÍu wmg ;rula ÿrg 

wmyiq ld¾hhls' tfy;aa úoHd;aul (Scientific) wxlkfhka oelajQ miq iEu w.hla u 

talSh l%uhlg m;aùu ksid lshjd f;areï .ekSu yd m%ldY lsÍu myiq lrhs' rEmh 

7'28 n,kak'

	 fldaI mrdihla úoHd;aul wxlkhg yeviõ lsÍu i|yd  my; oelafjk 

mshjr wkq.ukh lrkak'

Microsoft Office Excel  2010 i`oyd...

1' fldaI mrdih f;dard .ekSu

2' w.hhka yeviõ ixjdo fldgqj ,nd 

   .ekSu

3' Number Tab f;dard .ekSu

4' Percentage f;dard .eksu

5' wjYH oYu ia:dk m%udKh ilia lsÍu

6' OK úOdkh l%shd;aul lsÍu

LibreOffice Calc i`oyd...
1' fldaI mrdih f;dard .ekSu

2' w.hhka yeviõ ixjdo fldgqj ,nd 	

   .ekSu

3' Number Tab f;dard .ekSu

4' Percentage f;dard .eksu

5' wjYH oYu ia:dk m%udKh ilia lsÍu

6' OK úOdkh l%shd;aul lsÍu

rEmh 7'28 - úoHd;aul wxlkh



225fkdñf,a fnod yeÍu msKsihsfkdñf,a fnod yeÍu msKsihs224

7'5'8 fldaI mrdihla  Èk oelaúh yels wdldrhg yeviõ lsÍu

	 mß.Klhl Èkh (Date) 5$12$2014 u.ska olajkqfha  2014 uehs ui 12 fjks 

Èkhhs' fuh weußldkq l%uh fõ' ^mm/dd/yyyy&' ^mm-udih" dd - Èkh" yyyy - 
j¾Ih& me;=reïm;aj, Èkh wdldr lsysmhlska oelaúh yels h' rEmh 7'29 n,kak'

	

fldaI mrdihla Èkh oelaùug yeviõ lsÍu i|yd my; oelafjk mshjr  

wkq.ukh lrkak'

rEmh 7'29 - Èkh ±lafjk úúO yeviõ

Microsoft Office Excel  2010 i`oyd...

1' fldaI mrdih f;dard .ekSu

2' w.hka yeviõ ixjdo fldgqj ,nd 

   .ekSu

3' Number Tab f;dard .ekSu

4' Date f;dard .eksu

5' Èkh ±laúh hq;= wdldrh f;aÍu

6' OK úOdkh l%shd;aul lsÍu

LibreOffice Calc i`oyd...
1' fldaI mrdih f;dard .ekSu

2' w.hka yeviõ ixjdo fldgqj ,nd 	

   .ekSu

3' Number Tab f;dard .ekSu 

4' Date f;dard .eksu

5' Èkh ±laúh hq;= wdldrh f;aÍu

6' OK úOdkh l%shd;aul lsÍu

Microsoft Office Excel  2010      	
   i`oyd...
  1' fldaI mrdih f;dard .ekSu

  2' w.hka yeviõ ixjdo fldgqj ,nd 

     .ekSu

  3' Number Tab f;dard .ekSu 

  4' Scientific f;dard .eksu

  5'wjYH oYu ia:dk m%udKh ilia lsÍu

 6' OK úOdkh l%shd;aul lsÍu

 LibreOffice Calc i`oyd...
 1' fldaI mrdih f;dard .ekSu

 2' w.hka yeviõ ixjdo fldgqj ,nd 	

   .ekSu

 3' Number Tab f;dard .ekSu

 4' Scientific f;dard .eksu

 5' wjYH oYu ia:dk m%udKh ilia lsÍu

 6' OK úOdkh l%shd;aul lsÍu
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7'5'9 fldaI mrdihla fõ,dj oelaúh yels wdldrhg yeviõ lsÍu

	 mß.Klhl fõ,dj (Time) 10:35:53 AM f,i igyka lrhs' fuh hh:mm:ss 
AM$PM f,i fmdÿfõ olajhs' rEmh 7'30 n,kak' fuys hh hkq meh .Kk" mm 
hkq úkdä .Kk iy ss hkq ;;amr .Kk fõ'

rEmh 7'30 - fj,dj ±lafjk úúO yeviõ

	 fldaI mrdihla fõ,dj oelaùug yeviõ lsÍu i|yd  my; oelafjk mshjr 

wkq.ukh lrkak'

Microsoft Office Excel  2010 i`oyd...

1' fldaI mrdih f;dard .ekSu

2' w.hka yeviõ ixjdo fldgqj ,nd 

   .ekSu

3' Number Tab f;dard .ekSu

4' Time f;dard .eksu

5' fõ,dj ±laúh hq;= wdldrh f;aÍu 

6' OK úOdkh l%shd;aul lsÍu

LibreOffice Calc i`oyd...
1' fldaI mrdih f;dard .ekSu

2' w.hka yeviõ ixjdo fldgqj ,nd 	

   .ekSu

3' Number Tab f;dard .ekSu 

4' Time f;dard .eksu

5' fõ,dj ±laúh hq;= wdldrh f;aÍu 

6' OK úOdkh l%shd;aul lsÍu

7'5'10 fldaI mrdihla uqo,a f,i oelaúh yels wdldrhg yeviõ 
           lsÍu

	 uq,H jákdlula iys; w.hj, ^Currency& uqo,a i|yd Ndú; flfrk 

ixfla; ^$- fvd,¾" Rs - remsh,a&  w.hg bÈßfhka oelaúh hq;= h' 

	 fldaI mrdihla uq,H w.hka oelaùug yeviõ lsÍu i|yd  my; oelafjk 

mshjr wkq.ukh lrkak'

Microsoft Office Excel  2010 i`oyd...

1' fldaI mrdih f;dard .ekSu

2' w.hka yeviõ ixjdo fldgqj ,nd 

   .ekSu

3'  Number Tab f;dard .ekSu

4' Currency f;dard .ekSu

5' OK úOdkh l%shd;aul lsÍu

LibreOffice Calc i`oyd...
1' fldaI mrdih f;dard .ekSu

2' w.hka yeviõ ixjdo fldgqj ,nd 	

   .ekSu

3' Number Tab f;dard .ekSu

4' Currency f;dard .ekSu

5' OK úOdkh l%shd;aul lsÍu
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7'5'11  fldaI mrdihla tfl,a, jk f,i yeviõ lsÍu

	 fldaIj, f,an, fyda w.hka tfl,a,^Alignment& lsÍu ju"ueo iy ol=K 

jYfhka isÿ flf¾'

	 jï tfl,a, 		     ueo tfl,a, 		  ol=K tfl,a, 

      (Left Alignment)	        (Center Alignment)	           (Right Alignment)
	 fldaI mrdihla fõ,dj oelaùug yeviõ lsÍu i|yd  my; oelafjk mshjr 

wkq.ukh lrkak'

	 fldaI mrdihla tfl,a, lr oelaùug" yeviõ lsÍu i|yd  my; oelafjk 

mshjr wkq.ukh lrkak'

Microsoft Office Excel  2010 i`oyd...

1' fldaI mrdih f;dard .ekSu

2' w.hka yeviõ ixjdo fldgqj ,nd 

   .ekSu

3' Alignment Tab f;dard .ekSu

4' ju" ueo" ol=K hk tajdhska tlla 

   f;dard .ekSu 

5' OK úOdkh l%shd;aul lsÍu

LibreOffice Calc 2010 i`oyd...

1' fldaI mrdih f;dard .ekSu

2' w.hka yeviõ ixjdo fldgqj ,nd 	

   .ekSu

3' Alignment Tab f;dard .ekSu

4' ju" ueo" ol=K hk tajdhska tlla 

   f;dard .ekSu

5' OK úOdkh l%shd;aul lsÍu

  l%shdldrlu

yeviõ fuj,ï Ndú; lrñka iy iQ;% ,shd rEmh 7'31 u.ska olajd 

we;s jevm; ks¾udKh lrkak'

rEmh 7'31 - úúO yeviõ iys; jevm;la
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 7'6      idfmalaI iy ksrfmalaI fldaI fhduqj

7'6'1  iQ;%hla msgm;a lsÍu

	 mdif,a jdr úNd.hl isiqka ,nd .kakd ,l=Kq ,ehsia;=jla mka;sNdr 

.=re;=ud fyda .=re;=ñh úiska ilia lrkq ,efí' tla tla isiqjdf.a ,l=Kqj, tl;=j" 

idudkH w.h wdÈh fjka fjka jYfhka .Kkh lsÍu idïm%odhsl l%uhhs' tfy;a 

úoHq;a me;=reïm;a fhdod f.k fujeks ,l=Kq ,ehsia;= ieliSu ld¾hlaIu yd 

M,odhS l%uhls' thg fya;=j ,shk ,o iQ;%h msgm;a lsÍfuka fiiq .Kkh lsÍï 

b;d myiqfjka ,nd .ekSug yels ùuhs' tneúka jevm;l fma<shla Tiafia fyda 

;Srejla Tiafia iQ;%hla msgm;a lrk wdldrh úuid n,uq'

7'6'2  fldaIhl msrjqï ye~,h

	 jevmf;ys ´kE u fldaIhl ol=Kq mi my< fl<jf¾ msysá l=vd fldgqj 

msrjqï ye~,h (Fill handle) f,i kï flf¾' rEmh 7'32 n,kak'

 rEmh 7'32 - msrjqï ye~,h

msrjqï ye~,h

^1&  A ;Srej iy 2 fma<sh ueo tfl,a, lrkak'

^2&  2 fma<sh ;omeye (Bold) lrkak'

^3&  1 fma<sfha ud;Dldj háka brla w¢kak' wl=rej, m%udKh 16 lrkak'

^4&  A3,A4,A5 fldaI we, (Italic)  lrkak'

^5&  B6 fldaIhg ckjdß ui tl;=j ,nd .ekSug iQ;%hl sum Y%s;h fhdod ,shkak'

^6&  B7 fldaIhg ckjdß ui idudkHh ,nd .ekSug iQ;%hla average() Y%s;h fhdod 

    ,shkak'

^7& by; B6 iy B7 fldaIj, we;s iQ;% msgm;a lr b;sß udij, tl;=j iy 

    idudkHh fidhkak'

^8&  E3 fldaIhg l,d wxYfha  tl;=j ,nd .ekSug sum Y%s;h fhdod ,shkak'

^9&  F3 fldaIhg l,d wxYfha idudkHh ,nd .ekSug average() Y%s;h fhdod ,shkak'

^10& by; E3 iy F3 fldaIj, we;s iQ;% msgm;a lr b;sß wxYj, tl;=j iy idudkHh  

    fidhkak'
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7'6'3  iQ;% msgm;a lsÍu i|yd msrjqï ye`v,h Ndú; lsÍu

	 msrjqï ye~,h Ndú;fhka iQ;%hla msgm;a lsÍug my; oelafjk mshjr 

wkq.ukh lrkak' 

^1&' iQ;%h wvx.= fldaIh f;dard .ekSu

^2&' fldaIfha ol=Kq mi my< fl<jr msysá msrjqï ye~,h f;dard .ekSu

^3&' msrjqï ye~,h wjYH fldaIh fj; weof.k hdu

7'6'4  iQ;% msgm;a lsÍu i|yd Copy iy Paste  úOdk Ndú; lsÍu

	 Copy-Paste úOdk Ndú;fhka iQ;%hla msgm;a lsÍug my; oelafjk mshjr  

wkq.ukh lrkak' 

^1&'	iQ;%h wvx.= fldaIh f;dard .ekSu 

^2&'	Copy úOdkh ,nd §u ^Ctrl + C&

^3&'	msgm;a lsÍug wjYH  fldaI mrdih f;dard .ekSu

^4&'	Paste  úOdkh ,nd §u ^Ctrl + V&

7'6'5  idfmalaI iy ksrfmalaI fldaI fhduqj

	 fldaI ,smskhla ;Sre wlaIrhlska iy fma<s wxlhlska iukaú; fõ' iQ;%hl 

§ tjeks fldaI ,smskhla idfmalaI fldaI fhduqjla f,i ye¢kafõ' fvd,¾ ixfla;h 

^$& fma<s wxlh bÈßfha fh§fuka fma<s ksrfmalaI fldaI fhduqjla o" ;Sre wlaIrh 

bÈßfha fh§fuka ;Sre ksrfmalaI fldaI fhduqjla o"  fma<s wxlh iy ;Sre wlaIrh 

hk fol u bÈßfha fh§fuka fma<s iy ;Sre ksrfmalaI fldaI fhduqjla o ks¾udKh 

fõ'

  WodyrK 

H2	 - idfmalaI fldaI fhduqj ^Relative cell reference&
H$2 	 - fma<s ksrfmalaI fldaI fhduqj ^Row absolute cell reference&
$H2	 - ;Sre ksrfmalaI fldaI fhduqj ^Column absolute cell reference&
$H$2	 - fma<s iy ;Sre ksrfmalaI fldaI fhduqj ^Row and column absolute cell 		
	    reference&

7'6'6  idfmalaI fldaI ,smsk

	 iQ;%h fma<shla  Tiafia msgm;a jk úg tys wvx.= fldaI ,smskj, fma<s wxlh 

wkqhd; j fjkia fõ kï iy ;Srejla  Tiafia  msgm;a jk úg tys wvx.= fldaI 

,smskj, ;Sre wlaIrh wkqhd; j fjkia fõ kï tjeks fldaI ,smsk idfmalaI 

fldaI fhduqjla ^Relative cell reference& f,i ye¢kafõ' 
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WodyrK 

C1 fldaIfha ,shd we;s }A1+B1 hk iQ;%h C ;Srej Tiafia my<g;a 1 jk fma<sh 

Tiafia yryg;a msgm;a l< úg my; rEmh 7'33ys oelafjk mßÈ fldaI ,smsk 

idfmalaI j fjkia fõ' ta wkqj A1 iy B1 hk fldaI ,smsk" idfmalaI fldaI fhduq 

f,i i,lkq ,nhs'

7'6'7  fma<s ksrfmalaI fldaI fhduqj

	 iQ;%hla fma<shla Tiafia msgm;a jk úg iQ;%fha wvx.= fldaI ,smskj, fma<s 

wxlh fjkia fkdfõ kï tjeks fldaI ,smsk" fma<s ksrfmalaI fldaI fhduq ^Row 
absolute cell reference& f,i ye¢kafõ'

WodyrK 

C1 fldaIfha ,shd we;s }A$1+B$1 hk iQ;%h C ;Srej Tiafia my<g;a 1 jk fma<sh 

Tiafia yryg;a msgm;a l< úg my; rEmh 7'34 ys oelafjk mßÈ fldaI ,smsk ;Srej 

Tiafia my<g fjkia fkdfõ' tfy;a fldaI ,smskj, ;Sre wlaIrh fma<sh Tiafia 

idfmalaI j fjkia fõ' ta wkqj A$1 iy B$1 hk fldaI ,smsk" fma<s ksrfmalaI 

fldaI fhduq f,i y÷kajkq ,nhs'

rEmh 7'33 - idfmalaI fldaI fhduq iys; jevm;la 

;Sre wlaIr fjkia fõ'

fma<s wxlh fjkia 

         fõ'

;Sre wlaIr fjkia fõ'

fma<s wxlh fjkia 

        fkdfõ'

rEmh 7'34 - fma<s ksrfmalaI fldaI fhduq iys; jevm;la'
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WodyrK 2 

mekai,l ñ, okakd úg mekai,a lsysmhl ñ, fiùu i|yd rEmh 7'35 u.ska 

oelafjk jevm; n,kak'

rEmh 7'35 - idfmalaI iy ksrfmalaI fldaI fhduq 	

	 by; jevmf;ys C ;Srej Tiafia mekai,a m%udKhg idfmalaI j jákdlu 

.Kkh lsÍug C2 fldaIfha ,súh hq;= iQ;%h jkafka =A2*B2 fõ' fuh C ;Srej 

Tiafia my<g msgm;a lsÍfuka wfkl=;a mekai,a m%udKj, jákdlu ,nd .ekSug 

fkdyels h' 

	 iQ;%h msgm;a ùfï § A2 hkak A3,A4,A5 wd§ jYfhka idfmalaI j fjkia 

úh hq;= h' tfy;a  iEu úg u B2 fldaIh iQ;%h ;=< § fkdfjkia j mej;sh hq;= 

h' ta wkqj C2 fldaIfha ,súh hq;= iQ;%h jkafka =A2*B$2 fõ'

7'6'8  ;Sre ksrfmalaI fldaI fhduqj

	 iQ;%hla ;Srejla Tiafia msgm;a jk úg iQ;%fha wvx.= fldaI ,smskj, ;Sre 

wlaIr fjkia fkdfõ kï tjeks fldaI ,smsk ;Sre ksrfmalaI fldaI fhduqj 

^Column absolute cell reference& f,i ye¢kafõ'

WodyrK 1 

C1 fldaIfha ,shd we;s =$A1+$B1 hk iQ;%h C ;Srej Tiafia my<g;a 1 jk fma<sh 

Tiafia yryg;a msgm;a l< úg my; rEmh 7'36 ys oelafjk mßÈ fldaI ,smsk 

;Srej Tiafia my<g fjkia fõ' tfy;a fldaI ,smskj, ;Sre wlaIrh fma<sh Tiafia 

fjkia fkdfõ' ta wkqj $A1 iy $B1 hk fldaI ,smsk" ;Sre ksrfmalaI fma<s 

idfmalaI fldaI fhduq f,i y÷kajkq ,nhs'

;Sre wlaIr fjkia fkdfõ'

fma<s wxlh fjkia 

        fõ'

rEmh 7'36  - ;Sre ksrfmalaI fldaI fhduq iys; jevm;la'
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WodyrK 2 

my; oelafjk rEmh 7'37 jevmf;ys 3 jk fma<sh Tiafia tla tla ́ jrh wjidkfha 

,nd we;s uq¿ ,l=Kq ixLHdj fiùug wjYH iQ;%h =SUM($B2:B2& fõ'

rEmh 7'37  - ;Sre ksrfmalaI fldaI fhduq 			 

iys; Y%s; we;=<;a jevm;la'

th 3 jk fma<sh Tiafia msgm;a l< úg my; rEmh 7'38 mßÈ Èiafõ'

rEmh 7'38 - ;Sre ksrfmalaI idfmalaI fldaI fhduq 		

  iys; iQ;% we;=<;a jevm;la'

7'6'9  fma<s iy ;Sre ksrfmalaI fldaI ,smsk

	 iQ;%hla fma<shla Tiafia msgm;a jk úg iQ;%fha wvx.= fldaI ,smskj, fma<s 

wxlh fjkia fkdfõ kï iy ;Srejla Tiafia msgm;a jk úg iQ;%fha wvx.= fldaI 

,smskj, ;Sre wlaIr fjkia fkdfõ kï tjeks fldaI ,smsk fma<s iy ;Sre ksrfmalaI 

fldaI fhduq ^Row and column absolute cell reference& f,i ye¢kafõ'

	 fldaI ,smskhl fma<s wxlh iy ;Sre wlaIrh hk fol u bÈßfha $ ixfla;h 

fh§fuka $B$2 wdldrfha fma<s iy ;Sre ksrfmalaI fldaI fhduq  iQ;%j, § fhdod 

.; yel'

WodyrK 1

C1 fldaIfha ,shd we;s =$A$1+$B$1 iQ;%h A ;Srej Tiafia my<g;a " 1 jk fma<sh 

Tiafia yryg;a msgm;a l< úg my; oelafjk rEmh 7'39 mßÈ fldaI ,smsk fjkia 

fkd fõ'

;Sre wlaIrh fjkia fkdfõ'

fma<s wxlh fjkia 

        fkdfõ'

rEmh 7'39 - ;Sre iy fma<s ksrfmalaI fldaI fhduq 

	      iys; iQ;% we;=<;a jevm;la'



233fkdñf,a fnod yeÍu msKsihsfkdñf,a fnod yeÍu msKsihs232

	 ta wkqj fma<s iy ;Sre ksrfmalaI fldaI fhduq iys; iQ;%hla fma<shla fyda 

;Srejla Tiafia msgm;a lsÍfï § iQ;%h ;=< § fldaI fhduqj fjkia fkd fõ'

WodyrK 2

my; oelafjk rEmh 7'40 jevmf;ys D4 isg I4  olajd fmd;a ixLHdjg wod< ñ,;a" 

C5 isg C10 olajd ÿisï ixLHdjg wod< ñ,;a fidhd .ekSug wjYH fõ' C1 
fldaIhg fmd;l ñ, we;=<;a l< ú.i wod< ñ, m%udK o¾Ykh jk mßÈ iQ;% 

,shuq' iQ;%h ;=< § C1 fldaI ,smskh ksrfmalaI j mej;sh hq;= h' thg fya;=j 

jkafka iQ;%h 4 jk fma<sh Tiafia iy C ;Srej Tiafia msgm;a jk úg iQ;%h ;=< § 

C1fkdfjkia j ;sìh hq;= neúks' tneúka wod< iQ;% ;=< $C$1 f,i fhdouq'

rEmh 7'40 - ;Sre iy fma<s ksrfmalaI fldaI fhduq'

  l%shdldrlu

1' my; oelafjk iQ;%" fma<sh Tiafia iy ;Srej Tiafia msgm;a l< úg 

wkqhd; fldaIj, § o¾Ykh jk wdldrh ,shkak'
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 7'7      me;=reïm;a Ndú;fhka m%ia;dr ks¾udKh

	 ixLHd;aul j o;a; ksrEmKh jk wjia:dj, § th iei£u" úYaf,aIKh 

lsÍu" f;areï .ekSu yd bÈßm;a lsÍu ;rula ÿrg wmyiq ld¾hhls' tneúka yd 

m%ia;dr u.ska o;a; ksrEmKh lsÍu b;d id¾:l l%uhls' fï i|yd me;=reïm;a 

uDÿldx. fhdod .kakd wdldrh úuid n,uq'

m%ia;dr j¾. y÷kd .ksuq'

	 			   j.=j 7.15 - m%ia;dr j¾. 

      m%ia;dr j¾.h      uQ,sl msßie,eiau            Ndú;h

;Sre m%ia;dr (Column 
Chart)

o;a; whs;u fYa%‚ 

iuQyhla tl jr iei£u'

ldKav jYfhka iei£u'

o~q m%ia;dr (Bar Chart) o;a; whs;u fYa%‚ 

iuQyhla tl jr iei£u'

ldKav jYfhka iei£u'

f¾Ld m%ia;dr (Line 
Chart)

o;a; whs;u fY%a‚ 

iuQyhla tl jr iei£u'

ldKav jYfhka iei£u'

jg m%ia;dr (Pie Chart) o;a; whs;u fY%a‚hla 

m%;sY; w.h u.skaa 

iei£u'

XY m%ia;dr (XY Scatter 
Chart)

hq., jYfhka mj;sk 

w.h iei£u'

 2'  idfmalaI iy ksrfmalaI fldaI ,smsk w;r we;s fjki ,shd olajkak'
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;Sre m%ia;dr iy jg m%ia;dr ks¾udKh i|yd my; oelafjk jevm; fhdod .ksuq'

m%ia;drh ks¾udKh i|yd  my; oelafjk mshjr wkq.ukh lrkak'

m%ia;drhg ud;Dldjla ,nd §u i|yd  my; oelafjk mshjr wkq.ukh lrkak'

Microsoft Office Excel  2010 i`oyd...

1' o;a; mrdih f;dard .ekSu(A1:F3)
2' Insert → Chart
3' m%ia;dr j¾.h f;dard .ekSu

4' iqÿiq m%ia;drh f;dard .ekSu

LibreOffice Calc i`oyd...

1' o;a; mrdih f;dard .ekSu(A1:F3)
2' Insert → Chart
3' m%ia;dr j¾.h f;dard .ekSu

4' iqÿiq m%ia;drh f;dard .ekSu

5' Finish úOdkh ,nd §u

Microsoft Office Excel  2010 i`oyd...

 m%ia;dr f;dard .ekSu

 Layout→ Chart Title→ Above chart
 ud;Dldjla ghsma lsÍu

LibreOffice Calc i`oyd...

 m%ia;dr f;dard .ekSu

 Insert → Title
 ud;Dldjla ghsma lsrSu

 OK úOdkh ,nd §u

rEmh 7'41 - m%ia;dr ,l=Kq iys; jevm;

  l%shdldrlu

j.=j 7'15 ±lafjk tla tla m%ia;dr j¾. jvd;a u iqÿiq jk wjia:d i|yd 

WÞyrK fol ne.ska ,shkak'
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m%ia;drfha wlaI kï lsÍu i|yd  my; oelafjk mshjr wkq.ukh lrkak'

isiqka ,nd .;a uq¿ ,l=Kq jg m%ia;drhl olajuq'

  

Microsoft Office Excel  2010 i`oyd...

 1' m%ia;dr f;dard .ekSu

 2' Layout→ Axis Title
 3' Axis Type (Vertical or Horizontal)	
      wlaIr kï lsÍu

LibreOffice Calc i`oyd...

 1' m%ia;dr f;dard .ekSu

 2' Insert → Title
 3' wlaI kï lsrSu

 4' OK úOdkh ,nd §u

Microsoft Office Excel  2010 i`oyd...

1' o;a; mrdih f,i A1:A7 iy     	

  G1:G7 mrdi ,l=Kq lrkak'

2' Insert→ Chart →  Pie chart
 

LibreOffice Calc i`oyd...

 1' o;a; mrdih f,i A1:A7 iy     	

   G1:G7 mrdi ,l=Kq lrkak'

2' Insert→ Chart →  Pie chart
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WodyrK   Y= X2 - 5X - 3  j¾.c Y%s;fha m%ia;drh we£u

mshjr 1 ( jevmf;ys olajd we;s mßÈ  X i|yd -2 isg 7 olajd w.h we;=<;a lrkak'

mshjr 2 ( B2 fldaIhg my; oelafjk iQ;%h we;=<;a lrkak'

	    =B1^2-5*B1-3
mshjr 3 ( B2 fldaIfhys we;=<;a l< iQ;%h K2 fldaIh olajd msgm;a lrkak'

mshjr 4 ( o;a; mrdih f,i A1:K2 mrdih i,l=Kq lrkak'

mshjr 5 ( Insert →Chart →XY Scatter
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wNHdih

	 my; oelafjk jevm; weiqßka ms<s;=re imhkak'

^1&   2"6"10"14 we;=<;a fldaI mrdih kï lrkak'

^2&   9"10"11"12 we;=<;a fldaI mrdih kï lrkak'

^3&   6"7"8"10"11"12 we;=<;a fldaI mrdih kï lrkak'

^4&     A1 isg A4 olajd we;s w.hj, tl;=j A5 fldaIhg ,nd .ekSug wjYH iQ;%h  

     fldaI ,smsk muKla Ndú;fhka ,shkak'

^5&     A3 isg D3 olajd we;s w.hj, tl;=j E3 fldaIhg ,nd .ekSug wjYH iQ;%h  

     Y%s;hla Ndú;fhka ,shkak'

^6&   E3 ys iQ;%h E4 fldaIhg msgm;a lrk wdldrh i|yka lrkak'

^7&   E5 fldaIhg A1 isg D4 olajd idudkH w.h ,nd .ekSug wjYH iQ;%h Y%s;hla  

     Ndú;fhka ,shkak'

  l%shdldrlu

me;=reïm;a uDÿldx.hla Ndú; lrñka my; oelafjk jevm; ks¾udKh 

lrkak' fkdmeñ‚ isiqka ab u.ska olajd we;'
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;ks Y%s;hla Ndú; lrñka wod< iQ;% f.dvk.kak' 

^1& iuka l=udr ,nd .;a ,l=Kqj, tl;=j fiùug wjYH iQ;%h G2 fldaIhg 		

    we;=<;a lrkak' 

^2& iuka l=udr ,nd .;a ,l=Kqj, idudkHh fiùug wjYH iQ;%h H2 fldaIhg 		

    we;=<;a lrkak'        

^3& .‚;h úIhh i|yd isiqka ,nd we;s jeä u ,l=Kq ixLHdj fiùug wjYH 		

    iQ;%h B9 fldaIhg we;=<;a lrkak' 

^4& tla tla úIhh i|yd isiqka ,nd we;s wvq u ,l=Kq ixLHdj fiùug wjYH 		

    iQ;%h B10 fldaIhg we;=<;a lrkak' 

^5& tla tla úIhh i|yd fmkS isá isiqka .Kk fiùug wjYH iQ;%h B11  
    fldaIhg we;=<;a lrkak' 

^6&  tla tla úIhh i|yd ,nd we;s idudkH ,l=Kq fiùug wjYH iQ;%h B12 
    fldaIhg we;=<;a lrkak' 

idrdxYh

²	 oaúudk ;,hl isria ;Sre (Columns) yd ;sria fma<s (Rows) jYfhka msysá 

fldaI iuQyhlska jevm;  (Worksheet) ks¾udKh ù we;' 

²	 jevm;l we;s ;Sre kï lr we;af;a bx.%sis lemsg,a wlaIr fyda wlaIr ixfhdack 

fyda u.sks'

²	 jevm;l we;s fma<s kï lr we;af;a wxl u.sks'

²	 m<uq j ;Srefõ wlaIrh;a fojkq j fma<sfha wxlh;a fhdÞ fldaI kï lrkq 

,efí' th fldAI ,smskh (Cell Adress) f,i ye¢kafõ' 

²	 fldaIhl wka;¾.;h f,an,a (Label)" w.hka (Value) fyda iQ;% (Fomulae) 
j,ska tlls'

²	 iQ;%hla iudk (=) ,l=‚ka wdrïN lrkq ,efí' 

²	 fufyhjk (Operator) i|yd m%uqL;d wkqms<sfj<la mj;S'

²	 iQ;% ,sùu i|yd fldaI ,smsk" fufyhjk iy Y%s; (Function) Ndú; flf¾'

²	 f,an, iy w.hka yeviõ (Formatting) lsÍug yeviõ fuj,ï Ndú; flf¾' 

²	 iQ;%hla myiqfjka msgm;a lsÍug msrjqï ye~,h (Fill handle) Ndú; flf¾'

²	 idfmalaI fldaI fhduqjla (Relative cell reference) ksrfmalaI (Absolute) lsÍu 

i|yd fvd,¾ ixfla;h ($) Ndú; flf¾' 

²	 o;a; ixLHd;aul ksrEmKhg jvd m%ia;dr u.ska ksrEmKh" iei£u yd f;areï 

.ekSu myiq flf¾'


